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WWeellccoommee  ttoo 

 
A word from Spacejock Software: 
“yWriter is designed to help authors manage their novels during the 
creative stages. Add chapters or scenes, shuffle them at will and 
watch your novel grow with a daily word count tally. You do not have 
to write your files in yWriter, as long as you can save them from your 
chosen word processor as plain text or RTF. 
 
yWriter was developed by a best-selling, award-winning novelist, Simon Haynes, who 
also happens to be a programmer with over 20 years experience.  How did yWriter 
come about?  Back in 1999/2000 Simon was struggling to write his first novel in a word 
processor file, and he quickly realised there had to be a better way. yWriter was the 
result. 
 
The software is free to use, but you are welcome to donate towards the cost of 
development. 
 
Best of luck finishing your book!” 
 
 
About this Quickstart Guide: 
All content in this guide was written by Rowena Tayler-Henry (unless otherwise stated) 
for Spacejock Software and is intended to help new users of yWriter5 set up their first 
project. 
 
Please see online yWriter5 helpfile for comprehensive explanation of all features and 
menu items of the software.  This can be accessed by selecting „Contents‟ from the 
„Help‟ menu in the Main Screen of yWriter5. 
 
If viewed onscreen, the table of contents and in-text links can be clicked to navigate 
through the information.  At the bottom of each topic are suggested topics which you 
can click or, if you wish to return to the Table of Contents, click Where to next?. 
 
If printed out, you may also make use of the table of contents, in-text page references 
and Where to next? sections to find the information you seek. 
 
 
Where to next?  Find out how to start the program (next page) and set User Interface 
and Scene Fonts (next page) then create a project with the New Project Wizard (page 
4). 
  

http://www.spacejock.com/
http://www.spacejock.com/yWriter5.html
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SSttaarrttiinngg  tthhee  PPrrooggrraamm  
 
The following start-up process was devised by Simon Haynes and is reproduced here 
with slight modifications. 
 
Once you have installed the program from the yWriter5 download page 
(http://www.spacejock.com/yWriter5_Download.html): 
1.Double-click the shortcut on your desktop (shown right) if, during 
installation you did not untick the install desktop shortcut option. 

or 

Press the „Start‟ button in the left hand corner of your screen – move your cursor 
up to „All Programs‟ then „Spacejock Software‟ then „yWriter5‟ (folder) then 

„yWriter5‟ (icon ). 
 

2.If yWriter5 is running for the first time, the following message will appear:  "You 
seem to be running yWriter for the first time.  yWriter now has a 'Project Wizard' to 
help you get started:  Just click the Project menu, followed by 'New Project Wizard'." 
 
3.Press 'OK' and the Main Screen will appear. 
 
4.yWriter will ask whether you want to check for updates every week.  Press the 'Yes' 
button to be informed of program updates each time you run the software. 

 
 

SSeettttiinngg  UUsseerr  IInntteerrffaaccee  aanndd  SScceennee  FFoonnttss  
 
Selecting User Interface Font and Font Size: 
Before you proceed you might want to change the User Interface font size so it is the 
optimal size and font for you to read. 
1.Click on „Tools‟ then move your cursor down to 'Select User Interface Font' and 
select a font from the options:  Arial, Arial Unicode MS, MS Sans Serif, Tahoma, 
Trebuchet MS or Verdana. 
 
2.Select 'Set User Interface Font Size' from the 'Tools' menu and a box will appear.  
Enter a number between 8 and 16 in the box and press „OK‟ to save. 
 
 
Selecting Default Font for all scenes: 
1.Select „Set font across all scenes‟ from the „Scene‟ menu. 
 
2.Choose a font and size from the drop-
down lists. 
 
3. Press „OK‟ to save (as shown right). 
 
 
Where to next?  We recommend you start by using the New Project Wizard (next 
page). 

http://www.spacejock.com/yWriter5_Download.html
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NNeeww  PPrroojjeecctt  WWiizzaarrdd 
 
1.Select 'New Project Wizard' from the 'File' menu and a box will appear informing you 
that “This wizard will help you set up a yWriter project.  Fill in the required fields and 
click Next to progress through the wizard.  
At the end, click Finish.” 
 
2.Press the „Next‟ button to be taken to 
the „Step 1‟ tab. 
 
3.Type in the project title (eg. „Hal 
Spacejock‟) and press „Next‟ to proceed to 
the „Step 2‟ tab. 
 
4.Type in the author‟s name (eg. your 
name) and press „Next‟ to proceed to the 
„Step 3‟ tab. 
 
5.Step 3 asks you to specify your project 
folder.  Click the button as shown right. 

 
6.Go to the place on your hard drive where 
you want to save your project; click the 
'Make New Folder' button (as shown left) 
and enter the folder name (eg. „My Novel‟) 
and press „OK‟. 
 
7.Back in the yWriter Project Wizard, press 
'Next' to proceed to the „Finished‟ tab. 
 
8.Check that your „Title‟, „Author‟ and 
„Filepath‟ are correct then press 'Finish'.  A 
box will tell you “Now add chapters, 
characters and scenes to the project.” 
Press „OK‟.  You will now be returned to 
the yWriter main screen. 
 
 

Important note from Spacejock Software:  If you decide to move your yWriter5 
project file elsewhere, you MUST move the RTF and Autobackups folders too. The RTF 
folder contains the scene text, and the autobackups contains your backups. Failing to 
move the RTF folder - at the very least - will prevent your project working. 
 
 
Where to next?  At this point we suggest you decide on your Project Settings (next 
page) or you can start creating and editing Chapters and Scenes (page 6).  
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PPrroojjeecctt  SSeettttiinnggss 
 
Please note:  Pressing 'Cancel' while in the 'Project Settings' window means that you 
lose all information you entered.  It does not just cancel information entered in the 
last tab open. 
 
1.Select 'Project Settings' from the 'File' menu in the Main Screen. 
 
2.Enter project 'Title' and 'Description' in the text fields provided. 
 
3.Click the 'Author' tab and enter 'Author‟ (if not already filled) and 'Author Bio' 
(Biography) if you wish. 
 
4.Click the 'Deadlines' tab to view the Outline, Draft, 1st Edit, 2nd Edit and Final Edit 
'Begin' and 'End' dates.  The outline is automatically set to start from the project's 
date of creation.  To change a date click on it once 
and a date box will appear (as shown right).  Type in 
the day then press your tab key (to move across to 
the month box), type in the month then press your 
tab key (to move across to the year), type in the 
year and press 'OK' to save. 

 
5.Click the 'Rating Names' 
tab to enter four key 
aspects you wish to rate 
in scenes (with 1 being 
poor and 10 being 
excellent).  You can 
either press 'Reset to 
Defaults‟ (as shown left) 
or type in your own rating 
names. 
 
6.Press „Save‟ to save 
information entered in all 
tabs and exit. 

 
 
 
 
 
 

 
 
Where to next?  Now you can start creating and editing Chapters and Scenes (next 
page), Characters (page 8), Items and Locations (page 9).  
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CCrreeaattiinngg  aanndd  EEddiittiinngg  

CChhaapptteerrss  aanndd  SScceenneess  
 
The following process was devised by Simon Haynes and is reproduced here with slight 
modifications and screenshots. 
 
 
1.Select 'Create Multiple Chapters' from the 
'Chapter' menu and a box (shown right) will 
appear. 

 
2.Type in how many chapters you want to 
add to your project (the default is 25) and 
press 'OK' (as shown right). 
 

3.Click the first chapter in the chapter list of the 
Main Screen once to select it (as shown left). 
 
4.Select 'Add Scene' from the 'Scene' menu.  The 
Scene Editor Window (SEW) will open (as shown 
below). 

 
 

5. Enter the scene title in the long, narrow text box (eg. 'Protagonist discovers she's 
won the lottery').  In the screenshot above the box in question contains the words 
„Type Scene Title Here‟.  
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6.Click in the description box (underneath the Scene Title Box) and enter a short 
summary of your scene (if you wish).  This summary will form part of your auto-
synopsis later. 
 
7.Above the Scene Title Box is a „Viewpoint‟ Selector, an „Edit‟ button and an 'Add‟ 
button.  Press the „Add New‟ button to add a character to this scene (as shown on 
previous page). 
 
8.The character list will appear, initially empty.  Press the 'Add New Icon' as shown 
below. 

 
9.An empty character window will appear.  You must enter a short name, but 
everything else is optional (for full information on creating characters see the 
Characters topic (next page). 
 
10.Press „OK‟ to save, then „OK‟ on the character list. 
 
11.The 'Viewpoint' selector box should show the new character (from this point, you 
can press the 'Edit' button to edit your new character's details if you wish). 
 
12.The largest text box occupying the top half of the editor is where you write your 
scene.  Enter a sentence or two. 
 
13.You will notice that there are tabs near the top of the Scene Editor Window (as 
shown below).  The information you can enter into „Details‟ (eg. Status, Goals, Time, 
etc) and „Picture‟ fields are optional and can be learnt about later in this guide 
through the topics:  Characters Tab (page 17), the Details Tab (page 18) and the 
Picture Tab (page 17). 

 
 
14.Press the 'Save and Exit' button. You are now back on the Main Screen, and the new 
scene will be showing in the Scene List Area (the top right box). 
 
 
Further information: 
If you need further information about the yWriter5 user interface see the Main Screen 
and Scene Editor Window (SEW) topics in this guide.  For comprehensive explanation 
of the „Chapter‟ and „Scene‟ menus see the online helpfile which can be accessed by 
selecting „Contents‟ from the „Help‟ menu in the Main Screen. 
 
 
Where to next?  You can now explore the menus, adding more chapters and scenes or 
you might like to start creating Characters (next page), Items or Locations (page 9). 
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CChhaarraacctteerrss  
 
Please note:  Pressing 'Cancel' while in the „Characters‟ window means that you lose 
all information you entered.  It does not just cancel information entered in the last 
tab open. 
 
 
Creating a character: 
1.Click the 'Characters' menu and select 'View/Edit' to open the Characters, Items and 
Locations Box. 
 
2.Press this button to open an empty Character window. 

 
3.Enter Short Name, Full Name, Alternative Names, Tags and Description in the text 
fields as required.  If your new character will play a major role in your story, click the 

unselected radio button next to „Major‟ so that it changes from  to  (new 
characters are set as „Minor characters‟ by default). 
 
4.Click on the 'Bio' tab and enter biographical details of the character. 
 
5.Click on the 'Notes' tab and enter notes about the character (which you may wish to 
refer to later when writing scenes). 
 
6.Click on the 'Goals' tab and enter character goals and motivations. 
 
7.If you wish to add a picture of your character then click on the 'Picture' Tab.* 
 
5.Press the 'Select' button. 
 
6.Locate the picture on your hard drive and double-click it. 
 
7.Click 'OK' to save. 
 
*Tip from Spacejock Software:  A picture no larger than 300 pixels long and 400 pixels 
wide is recommended as large images are slow to load. 
 
 
Editing a character: 
1.Select 'View/Edit‟ from the „Characters‟ menu. 
 
2.Double click the Character you wish to edit or select the character and press this 
button to open the box. 

 
 
 

Where to next?  Now you have created Chapters, Scenes (pages 6-7) and Characters 
(this page), you can now create Items or Locations (next page) or start exploring the 
Main Screen (page 11). 
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IItteemmss  &&  LLooccaattiioonnss  
 
Please note:  Pressing 'Cancel' while in the 'Item‟ or „Locations‟ window means that 
you lose all information you entered.  It does not just cancel information entered in 
the last tab open. 
 
 
Creating an item or location: 
1.Click 'Items' or „Locations‟ menu and select 'View/Edit' to open the Characters, Items 
and Locations Box. 
 
2.Press this button to open the new item or location window. 

 
 
3.Enter Name, Description and Tags if required. 
 
4.If you wish to add a picture then click the 'Picture' Tab.* 
 
5.Click the 'Select' button. 
 
6.Locate the picture and double-click on it. 
 
7.Click 'OK' to save. 
 
*Tip from Spacejock Software:  A picture no larger than 300 pixels long and 400 pixels 
wide is recommended as large images are slow to load. 
 
 
Editing an item or location: 
1.Select 'View/Edit from the 'Items' or „Locations‟ menu. 
 
2.Double click the item or location you wish to edit or select the item or location and 
press this button to open the box and begin editing. 

 
 
 

Where to next?  You can learn how to organise your Characters, Items and Locations 
(next page) or start exploring the Main Screen (page 11) and Scene Editor Window 
(page 16). 
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Icon Purposes: 

 
Displays list of Characters. 

 
Displays list of Items. 

 
Displays list of Locations. 

 

Adds another item to the selected list 
and opens box for editing. 

 

Opens selected Character, Item or 
Location box for editing. 

 

Deletes selected Character, Item or 
Location. 

 

Prints selected List (Characters, Items 
or Locations). 

 

OOrrggaanniissiinngg  CChhaarraacctteerrss,,  IItteemmss  aanndd  LLooccaattiioonnss  
 
Select „View/Edit‟ from the 
„Characters‟, „Items‟ or 
„Locations‟ menus to open the 
box (shown right) 
 
 
If you have lots of characters 
and wish to only show the 
major characters, click the 
box next to „Only show major 
characters‟ so a tick appears 
(like this ). 
 
 

Adding characters, items or locations 
to scenes: 
Once you have created a Character, 
Item or Location, you can add it to the 
selected scene by selecting 'Add 
Character/Item/Location to current 
scene' from the appropriate menu in 
the main screen. 

or 
Go to the Characters, Items or Locations tab in the Scene Information Area (as 
explained on page 14) of the Main Screen (next page) and drag it across from the „All 
[characters, items or locations]‟ list to the „In this scene‟ list. 
 
 
Where to next?  Familiarise yourself with the Main Screen (next page) which is made 
up of the Chapters Area (page 12), the Scene List Area (page 13), the Scene 
Information Area (page 14), and the Project Notes Tab (page 15). 
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EExxpplloorriinngg  tthhee  MMaaiinn  SSccrreeeenn  

 
Changing Project Title or Author Name: 
Highlight existing text in the 'Project Title' or 'Author' text boxes (by clicking and 
dragging over the text) and type your new title or name text. 
 
 
Resizing Main Screen (or Scene Editor Window): 

1.Move your cursor to the bottom right hand corner so it becomes a double 
sided arrow (as shown right). 
 
2.Click, drag and drop to make the window larger or smaller. 

or 
To make the window full screen size, press the maximise button in the 
top right hand corner of the window (as shown left). 

To return the window to its previous size, press this button . 
 
 
Where to next?  Familiarise yourself with the Chapters Area (next page), the Scene 
List Area (page 13), the Scene Information Area (page 14), and the Project Notes Tab 
(page 15). 
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CChhaapptteerrss  AArreeaa  
 
In the Chapters Area you can see the title of 
each chapter, the W column shows the number 
of words in each chapter, the S column shows 
the number of scenes in each chapter and the P 
column shows the running total words up to 
that point. 
 
At the bottom is a box where the selected 
chapter's description is shown (if one is 
entered). 
 
 
Resizing Chapters Area in Main Screen: 
Follow this procedure if you have already 
resized your Main Screen (previous page) and 
are still unable to see the chapter title or other 
details. 

1.Move your cursor  to the border between 
the Chapter and Scene box in the Main Screen 
until the cross with arrows (as shown below) 
appears. 

 
2.Click and drag the border over as far as necessary to see the Chapter names and 
details. 
 
 
Opening chapter details box: 
1.Double-click on the chapter you wish to open. 
 
2.You can then change the chapter's 'Title' and 'Description'. 
 
3.When you have finished, press 'OK' to save your changes and close the box.  Please 
Note:  if you press 'Exit' your changes will not be saved. 
 
 
Where to next?  You can now explore the Scene List Area (next page), the Scene 
Information Area (page 14) and the Project Notes Tab (page 15) on the right hand side 
of the Main Screen (previous page). 
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SScceennee  LLiisstt  AArreeaa  
 

 
 
 
Meaning of columns in Scene List Area: 

 „Viewpoint‟ indicates from which character's perspective the scene is written 
this can be toggled in the Viewpoint Selector (step 7 of page 7) in the Content 
Tab (page 16) of the Scene Editor Window (page 16). 

  „Words‟ displays how many words are in the scene. 

 „Scene‟ displays the scene title. 

 „Status‟ indicates whether you have set the status to 'Outline', 'Draft', '1st Edit', 
'2nd Edit' or 'Done' in the Details Tab (step 5 of page 18) of the Scene Editor 
Window. 

 „A/R‟ indicates whether you have set the type of scene to 'Action' or 'Reaction' 
in the Details Tab (step 2 of page 18) of the Scene Editor Window. 

 „Filename‟ displays the filename for the scene. 

 „Letters‟ displays the number of letters present in the scene. 

 „Characters‟ displays the characters you have set as present in the scene in the 
Scene Information Area (next page). 

 „Locations‟ displays the locations you have set for the scene. 

 „Items‟ displays the items you have set as present in the scene. 
 
 
Resizing columns in Scene List Area: 

1.Move your cursor  between two columns until it becomes a cross with left and 
right arrows (as shown). 

 
 
2.Hold down your mouse button and move left to make the left column smaller or 
right to make the left column bigger. 

 
 
Opening scene to begin editing: 
Find a scene in the Scene List Area and double-click it or select 'Edit selected scene' 

from 'Scene' menu.  The icon next to the open scene will change from  to . 
 
 
Rearranging scenes: 
Click, drag and drop scenes into the position you want them. 
 
 
Where to next?  Below the Scene List Area is the Scene Information Area (next page). 
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SScceennee  IInnffoorrmmaattiioonn  AArreeaa  
 
Viewing scene information: 
Under the Scene List area, all information entered for the selected scene (except 
scene ratings) is shown.  Click between the tabs to view the information. 

 
 
Meaning of icons in the 
Scene Information 
Area: 

 Minor Character 

 Major Character 
 Location 
 Item 

 
 

Editing scene information: 
If you wish to edit the 'Name', 'Description', 'Content', 'Scene Notes' or 'Goals' you must 
click the 'Edit' button and the selected scene's Editor Window will open. 
 
 
Adding characters, locations or items to a scene: 
If you wish to add existing Characters, Items or Locations to the selected scene: 
1.Click on the appropriate tab (Characters, Items or Locations) 
 
2.Click, drag and drop the desired object from the 'All Characters/Locations/Items' list 
to the 'In this scene' list. 

or 
Right click-the desired object and select 'Add to all selected scenes' (you can select 
multiple scenes by holding down the „Ctrl‟ button on your keyboard and clicking the 
scenes in the Scene List Area. 
 
 
Editing character, location or item details: 
Click on the appropriate tab and double-click the desired object to open that object's 
editor box to begin editing. 
 
 
Resizing Scene Information Area in Main Screen: 

1.Move your cursor to the border between the Scene Name Box and the 
Scene Information Area until it becomes a cross with up and down arrows (as 
shown right). 

 
2.Click and drag the border as far as you need to view your information. 
 
 
Where to next?  Having looked at the Chapters Area (page 12), Scene List Area (page 
13) and Scene Information Area (this page), the last part of the Main Screen (page 11) 
to explore is the Project Notes Tab (next page).  
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PPrroojjeecctt  NNootteess  TTaabb  
 
Viewing notes: 
Click the 'Projects Notes' tab (this is next to 'Scenes' and underneath 'Author' in the 
Main Screen).  When you have written a note for the project, it will appear in the 
Project Note List Area and can be read in the text box at the bottom of the screen (as 
shown below).  Click the 'Scenes' tab next to the 'Notes' tab to get back to the Scene 
List Area. 
 
 
Resizing notes: 

1.Move your cursor to the border between the Notes Name Box and the Notes 
Content Box until it becomes a cross with up and down arrows (as shown below). 

 
2.Click, drag and drop the border as far as necessary to view your notes. 

 
 
Creating a new note: 
1.Click the 'Projects Notes' 
tab (as shown). 
 
2.Press the 'New' button. 
 
3.Replace the words 'New 
Note' (default title) in the 
narrow text box with your 
own note title (eg. 'Low 
Note‟ as shown). 
 
4.Write your notes in the 
larger text box. 
 
5.Press 'Save' to save your 
note. 
 
 
Editing a note: 
1.Click on a note and its information will appear in the Notes Editor box. 
 
2.Press 'Edit'. 
 
3.Make your changes and press 'Save'. 
 
 
Where to next?  Familiarise yourself with the Scene Editor Window (SEW) (next page) 
which is made up of the Content Tab (next page), the Characters Tab (page 17, the 
Picture Tab (page 17) and the Details Tab (page 18). 
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EExxpplloorriinngg  tthhee  SScceennee  EEddiittoorr  WWiinnddooww  ((SSEEWW))  

CCoonntteenntt  TTaabb  

 
The Scene Editor Window appears when you open a scene from the Scene List Area 
(page 13) in the Main Screen (page 11). 
 
For an explanation of how to enter information into the Content Tab see steps 4 to 13 
of the Chapters and Scenes topic (page 6). 
 
 
Jumping to different scenes and chapters in the Scene Editor Window: 
Make your selection from the 'Ch' (Chapter) and/or „Sc‟ (Scene) drop-down menus to 
go to that Chapter and/or Scene. 
 
 
Formatting text: 
You will already have selected a default font for scenes (page 3) but you can also 
select a different font and font size for your scene from the drop-down lists on the 
right just above the content box.  Or you may add emphasis by selecting all or a 
portion of the text and pressing the 'B' for bold, 'I' for italics, 'U' for underlined buttons 
on the left just above the content box. 
 
 
Where to next?  The Scene Editor Window (this page) also has a Characters Tab (next 
page), a Picture Tab (next page) and a Details Tab (page 18). 
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CChhaarraacctteerrss  TTaabb  
 
If you have not created a character (page 8) yet, do so now. 
 
To make a character present in the current scene from the Scene Editor Window: 
1.Click the 'Characters' tab. 
 
2.Click, drag and drop the character from the 'All characters' list (on right) to the 
'Present in scene‟ list (on left). 

 

 
 
Warning:  If you wish to edit the 'Description' and 'Details' of a character then double-
click on their name to open their character box.  DO NOT try to edit them in the 
„Description‟ and „Notes‟ text fields in the 'Characters' tab because your changes will 
not be saved. 
 
 
 

PPiiccttuurree  TTaabb  
 
To add a picture to the scene: 
1.Click the 'Picture' Tab.* 
 
2.Press the 'Select' button. 
 
3.Locate the picture and double-click on it or click it once and press 'Open'. 
 
*Tip from Spacejock Software:  A picture no larger than 300 pixels long and 400 pixels 
wide is recommended as large images are slow to load. 
 
 
Where to next?  We suggest you explore the Details Tab (next page) of the Scene 
Editor Window (page 16) before moving on to setting up Extra Tools (pages 19-22). 
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DDeettaaiillss  TTaabb  

 
Setting Optional Scene Details: 
1.Open the scene you wish to set details for by double-clicking it in the Scene List 
Area of the Main Screen then click on the 'Details' tab of the Scene Editor Window. 
 
2.Set the 'Type of Scene' by selecting 'Action' or 'Reaction' from the drop-down list. 
 
3.Give a rating from 1 to 10 for the four aspect names you defined in Project Settings 
(step 5 of page 5) (if you have not defined them yet then they will be blank). 
 
4.Set the 'Importance' by selecting 'Main plot' or 'Subplot‟ from the drop-down list. 
 
5.Set the „Status‟ by selecting „Outline‟, „Draft‟, „1st Edit‟, „2nd Edit‟ or „Done‟ from 
the drop-down list. 
 
6.Set the „Day/Hour/Minute‟ the scene begins in with the three drop-down lists. 
 
7.Set the „Amount of time scene lasts‟ with the three drop-down lists. 
 
8.Enter information for the current scene into the narrow text boxes entitled „Goal‟, 
„Conflict‟ and „Outcome‟. 
 
9.Add Notes for the scene in the large text box (if you do so the scene will have this 

icon  in the Scene List until the notes are removed). 
 
 
Where to next?  Now is the time to set up Extra Tools (next page) which include a 
Spellchecker (pages 19-20), Daily Word Count Target (page 21) and Backups (page 22).  
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SSeettttiinngg  uupp  EExxttrraa  TToooollss  

IInnssttaalllliinngg  aanndd  UUssiinngg  tthhee  SSppeellllcchheecckkeerr  
 
The information on this page was written by Simon Haynes and is reproduced here 
with slight modifications and screenshots. 
 
To enable the spell check feature, follow these instructions: 
1.Open a Scene Editor Window (you can do this after adding a chapter and at least one 
scene) by double-clicking a scene in the Scene List Area (page 13) of the Main Screen 
(page 11). 

 
2.Select 'Install Dictionary' from the „Spelling‟ menu (as shown below). 

 
 
3.The box below will appear.  Press „Yes‟ (as shown).  This will download and install a 
free set of files containing a comprehensive English word list.  It will also activate the 
yWriter spelling dictionary. 

 
 

4.Wait for the zip to download and install itself.  The box below will appear.  Press 
'OK' (as shown). 

 
 
5.Restart yWriter (exit program and open program again) to enable the spellchecker. 
 
 
If it fails, it is usually due to your firewall blocking yWriter.  If so, follow these manual 
instructions: 
 
1.Download the file 12dicts-5.0.zip (or later) from: 

http://prdownloads.sourceforge.net/wordlist/ 
 
2.Extract to the Dictionary folder inside your yWriter5 data folder (Documents and 
Settings\USERNAME\Application Data\Spacejock Software\yWriter5\) then perform step 
5 above. 
  

http://prdownloads.sourceforge.net/wordlist/
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Checking spelling: 
After installing the dictionary, your 'Spelling' 
menu will have more options (as shown right). 
Select 'Check Now' from the 'Spelling' menu.  
Words not present in the installed dictionary or 
not entered into the „Custom Dictionary‟ will be 
highlighted red by default.  Such words will 
remain red until you either fix the spelling 
manually and select „Check Now‟ from the 
„Spelling‟ menu again or until you add the word 
to the custom dictionary (as explained below).  To clear Spell-checked highlights, 
select 'Clear' from the 'Spelling‟ menu.  Known character highlights (as explained 
below) will remain. 
 
 
Highlighting known characters: 
Select 'Highlight known characters' from the „Edit‟ menu so a tick appears before the 

said menu option (like this ).  Known characters (present in your Characters list) 
will now show up as blue (by default) when you select „Check Now‟ from the „Spelling‟ 
menu and not appear red as if they are spelling errors. 
 
 
Adding a word to the Custom Dictionary: 
1.Type the word you wish to add in the Content text box of the Scene Editor Window. 
 
2.Double-click the word to highlight it. 
 
2.Right-click the highlighted word with your mouse and select the 'Add selection to 
custom dictionary'.  This means the word will appear normal and not be highlighted 
red when you next select 'Check Now' from the 'Spelling' menu. 
 
 
Adding and removing words directly in the Custom Dictionary file: 
1.Select 'Open the dictionary folder' from the 'Spelling' menu. 
 
2.Double-click the 'Custom' text file. 
 
3.Highlight and delete the unwanted word or type in a list of your own words.  Make 
sure your list has only one word per line with one return before and after each word. 
 
 
Automatic spellchecking: 
Select 'Spell check on display and save' from the „Spelling‟ menu so a tick appears 

before the said menu option (like this ).  The program will now perform a 
spellcheck whenever the scenes are saved or opened. 
 
 
Where to next?  Other tools to be set up are the Daily Word Count Target (next page) 
and Backups (page (22).  
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DDaaiillyy  WWoorrdd  CCoouunntt  TTaarrggeett  
 
1.Select 'Daily Word Count 
Target' from the 'Tools' Menu. 
 
2.Press the 'Copy' button to copy 
the 'Words in Project now' to the 
„Starting Count‟ box. 
 
3.Click on the date entitled 'Start 
date' and a box will appear for 
you to enter the current day, 
month and year.  Once the date 
is entered, press 'OK'. 
 
4.Click on the date entitled 'End 
Date' and a box will appear for 
you to enter the day, month and 
year when you intend to reach 
your target.  Once the date is 
entered, press „OK‟. 
 
5.Double-click the number in the 
Target Count box and type the 
number of words you intend to 
write between the given dates 
(not the finished word count). 
 
6.Press „Save‟ to save and close. 
 
7.After writing more words in a scene or scenes you can go back and select 'Daily Word 
Count target' from the 'Tools' menu to see your progress.  You can check the expected 
„Total words at end date‟, the „Number of days left‟ to reach your target, the 
recommended average of „Words to write per day‟, the number of words „You need to 
write‟ (in red) and how many words you have written (displayed in words, as a 
percentage and represented visually). 
 
 
Where to next?  Now you have added the Spellchecker (page 19-20) and set up your 
Daily Word Count Target (this page), you can now choose your Backups Options (next 
page) and read about the Extra Support that is available (page 23). 
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BBaacckkuuppss  
 
The following information on backing up was written by Simon Haynes, writer and 
creator of yWriter, and is reproduced here with slight modifications and a screenshot. 
 
 
Default scene backup utility: 
When you open a scene, yWriter saves it to [Project Folder]\Autobackups\YYYY-MM-DD 
(where YYYY-MM-DD represents the current).  At regular intervals, and as you work on 
the scene, yWriter will save the contents to the same file.  Nevertheless, Spacejock 
Software recommends that you set yWriter to save backups to sequential files. 
 
 
Setting yWriter5 to backup to sequential siles: 
If you select the 'Sequential files' option, a new backup file will be created at the 
intervals specified.  This file will be given the name of the file plus the current time. 
 
1.Click the 'Tools' menu, then 'Backups' and select 'Set Autobackup options'. 
 
2.Change from „Save 
backups to the same file' 
to „Save backups to 
sequential files' by 
clicking the unselected 
radio button so that it 

changes from  to . 
 
3.Enter a number into 
the 'mins' text box (the 
default is 5).  Thus, if 
you enter „6‟ your work 
will be backed up ever 6 
minutes. 
 
4.You may also click on 
the box in front of 
„Create a text file mirror 
when saving rtf‟ so that 
it changes from  to . 
 
5.Press 'OK' to save your changes. 
 
 
Where to next?  You are almost at the end of this Quickstart Guide to yWriter5.  
Should you seek further information, read the Extra Support topic (next page) or 
consult the comprehensive online guide to yWriter5 which can be accessed by 
selecting „Contents‟ from the „Help‟ menu in the Main Screen. 
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EExxttrraa  SSuuppppoorrtt 

 
yWriter Google Group: 
You can join the yWriter Google Group to participate in discussions, seek help, report 
bugs and suggest new features at this address: 

http://groups.google.com/group/ywriter 
 
 
SpaceJock Software’s Writing Resources: 
Simon Haynes, writer and creator of yWriter 5, has written a number of articles on 
'The Act of Writing‟ and the „Business of Writing' which can be found at: 

http://www.spacejock.com.au/Articles.html 
 

Similarly, a list of recommended sites for writers can be found at: 
http://www.spacejock.com.au/Links.html 

 
 
About the creator of yWriter5, Simon Haynes: 
“Simon Haynes is the author of four Hal Spacejock novels, a number of 
articles on writing and publishing, and several short stories, one of 
which collected an Aurealis Award in 2001. He divides his time between 
writing fiction and computer software, with the occasional round of golf 
thrown in for a laugh. 
 
Born in the UK and raised in the south of Spain, Simon emigrated to 
Australia with his family in 1983. He's a founding member of Andromeda 
Spaceways Inflight Magazine, and lives in Perth with his wife and two 
children.  His goal is to write fifteen Hal Spacejock books before someone takes his 
keyboard away.” 
 
To contact Simon, visit this contact page: 

http://www.spacejock.com.au/contact.html 
 
 
About the author of this guide, Rowena Tayler-Henry: 
Rowena Tayler-Henry has written the user documentation for yWriter5, several poems, 
two unpublished children‟s books and an unproduced play.  She has qualifications in 
the arts (History, International Relations and Theatre Studies) and education (Primary 
Teaching) and she is pursuing a career in writing, user documentation and web design.  
Should you wish to contact her about this quickstart guide or her online helpfile for 
yWriter5, please write to rowena@dublin.ie and she will do her best to help. 
 
 
Where to next?  You have come to the end of this Quickstart Guide to yWriter5.  
Should you seek further information on any feature or menu item of yWriter5, consult 
the comprehensive online guide to yWriter5 which can be accessed by selecting 
„Contents‟ from the „Help‟ menu in the Main Screen.  Good luck with your writing! 

http://groups.google.com/group/ywriter
http://www.spacejock.com.au/Articles.html?yWriter.5.0.2.8
http://www.spacejock.com.au/Links.html
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